
GeoAccess Professional – Getting Started Guide 

Page 1 

 

 
Widenbar and Associates 
GeoAccess Professional 

 
 
 

Getting Started 
Documentation 

 
 
 

V2.11 2009 
 

 
Software Installation and Registration 
Installation of GeoAccessPro is easy…  use the Start | Run command or Windows Explorer to navigate 
to and run the Setup.exe program in the Setup directory on the installation CD. Follow the instructions 
on screen and setup will do the rest. You can make a desktop shortcut to the file GeoAccessPro.exe if 
you want quick access to the program. The system will ask for a Validation Code after installation – this 
will be provided separately with your installation CD.  
 
User Guides 
This Overview provides a Guide to the things you need to know to quickly get the most out of 
GeoAccessPro. It deals with general information regarding loading and saving data, using filters, using 
colour files etc. There are three separate Function Guides that describe the specific functions found in 
GeoAccessPro  - the Statistics User Guide, the Geotech User Guide and the MultiPlot User Guide. PDF 
files are installed into Documentation directory in the GeoAccessPro program directory.  
 
Getting Started 
The Setup program copies some example data, colour, symbol and filter files to the program directory in 
which GeoAccessPro is installed (typically ‘C:\Program Files\GeoAccess Professional’. These can be 
used to get going and experiment with the program. Online help is accessed by using the F1 key or from 
the Help menu. 
 
File Management 
GeoAccessPro keeps track separately of the directories in which different types of files are kept, so it is 
advantageous to make different directories to store colour, symbol, filter files etc. Then, when using 
different data directories, you can easily find the other file types you need. 
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This Overview Guide tells you how to accomplish various general tasks and contains the following 
sections: 

• How To Load Data  
• How To Use Filters 
• How To Save Data 
• How To View and Edit Data  
• How To Use The Main Dialog Box 
• How To Use Grouping and Overlays 
• How To Use Colour Files 
• How To Use Symbol Files 
• How To Use The Clipboard and Save Bitmaps 
• How To Get Hardcopy on a Printer or Plotter 

 

The separate Function Guides contain information on the functions in GeoAccessPro. 
• Statistics, Grouped Statistics and Box Plots (Statistics User Guide) 
• Probability Plots and Histograms (Statistics User Guide) 
• Correlation Analysis (Statistics User Guide) 
• XY and  XYZ Plots, and Contouring (MultiPlot User Guide) 
• Variograms  (Statistics User Guide) 
• Geotech Oriented Core Transformation (Geotech User Guide) 
• Geotech StereoPlots (Geotech User Guide) 
• Geotech Sections (Geotech User Guide) 
• Geotech Plans (Geotech User Guide) 

 
How To Load Data 
Prior to loading data, you need to open a file or database using the File Open command or Recent Files 
List.  

The File Menu 

 
The File menu provides access to commands that enable you to open files of various sorts. It also 
displays a list of the last six files opened; these files can be re-opened simply by selecting their name. 
The menu can also be accessed by using the right mouse button on the GeoAccessPro Main Form. 

The types of data that can be opened are shown on the menu. 
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Selecting any data type will show a File Open dialog box, as shown at right. 

 

 
 
On selecting a file, the Data Selection Dialog Box will be shown (see Page 5).  
If an Access database is selected, a dialog box will open allowing you to select any of the tables or 
queries in the database. 
 
The Data Selection Dialog Box 
 

 
 
At this point GeoAccessPro has simply looked at the file to determine what variables it contains, and will 
show a screen similar to the one above. 
The dialog has two list boxes on the left that show the numeric and alpha fields or variables found in the 
data set. Variables can be selected from either or both list boxes using the left mouse button. In 
standard Windows fashion, using Ctrl-Left Mouse will add (or remove) selected variables, while Shift-
Left Mouse will add all variables between the first and last selected. Buttons are also provided to select 
all numeric, all alpha, or all variables. 
Once one of the Load buttons has been used the appropriate data is loaded into memory and the 
GeoAccessPro Function Dialog Box appears.  
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How To Use Filters 
Filters allow you to selectively load part of a data set using numeric or alphanumeric conditions applied 
to any of the variables. You don’t necessarily need to load the variables that are used in the filtering. 

Prior to setting up filters for loading data, you need to open a file using the File Open command or 
Recent Files List. This will show the Data Selection Dialog Box, which includes a section for specifying 
filter conditions, as shown on  the left. 
This dialog has the following components: The Fields section displays drop down list boxes of the 
variables in the currently selected data file. 
The Actions section shows list boxes of the available conditions that can be applied in filtering. 

The Values section lets you enter numeric values or strings to use in filtering. If string are used, the 
wildcards * and ? can be used to match all or single characters. For example FR* finds all occurrences 
starting with FR, while DD1?? will find entries with DD1 followed by any other two characters; for 
example, DD100 and DD11A will be found, but not DD1000. 
The And/Or Section allows multiple conditions to be evaluated in combination (using And) or individually 
(using Or). 
Buttons are available to Clear all filter conditions and to Save and Recall filters in files. GeoAccessPro 
remembers the directory location of filter files, so that all filter files can be conveniently kept in one 
location. Long filenames can be used, so meaningful names can be given to filter files. When you have 
specified the filter conditions, you can use the one of the various Load… buttons to actually load the 
data. 
 
How To Save Data 
Once a data set has been loaded into memory, GeoAccessPro can be used to save this data in a variety 
of formats. It can be saved in the same format as loaded or in other formats, so that the system can be 
used for data translation. The Save option is accessed from the  Function Dialog Box once data has 
been loaded. 

  
Selecting the save option brings up the dialog box shown below. You can select one or more file save 
options, and change the names of files to save if required. To save as an Access Table, the Access 
database must already exist. 
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How to View and Edit Data  
Once a data set has been loaded into memory, the data can be viewed and/or edited. The View option 
is accessed from the Function Dialog Box, and opens a screen similar to the one below. 

 
 
The Function Dialog Box 
When data has been loaded into memory, the Function Dialog Box is shown. This is where all the 
functions available within GeoAccessPro can be accessed. The functions operate directly on the data 
which has been loaded into memory 
You can, of course, load multiple files (of any type), and a new Function Dialog Box will open for each 
data set. 
A typical screen is shown below. 

 
All of the modules of GeoAccessPro are accessible from this one screen, using the Tabs at the top of 
the Function Dialog Box. 
The purpose of the Function Dialog Box is to let you control the parameters that will be used to run the 
functions within GeoAccessPro. In general, when you select one of the tabs after opening a file for the 
first time, the system will make some intelligent guesses about which fields you might want to use. For 
example, if you are doing a Geotech Section, it will look for fields called EAST, EASTING, X or 
something similar to use as the X or Easting coordinate values for the display. It will also fill in default 
values and options based on typical responses, or on your previous responses if you have used the 
function before.  
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It is usually possible to press the green OK button without entering anything at all The function will run 
and display the results, usually in one or more graphics windows.  It is possible to return to the Function 
Dialog Box at any time and either run the same function using different conditions or variables, or run a 
different function using the same data. 
On all of the Tabs of the Main Dialog Box, any boxes that must be filled in are coloured red, whereas 
optional responses will either be blank initially or blue if filled. 
After a data set has been loaded and one of the functions has been run, the parameters used for that 
function on that file are saved in the current directory (i.e. the directory from which the file was loaded). 
Then, the next time you use that function on that file, all the parameters previously used will be re-
loaded as defaults. 
 
How To Use Grouping and Overlays 
The concept of grouping allows you to pick one (or sometimes two) variables and have the system 
generate groups of data for all identical entries of that variable. The data does not have to be sorted, 
and you don’t need to know the entries in the grouping field – the system will figure out what subsets to 
generate and open as many windows as necessary.  
When a number of windows of the same type are displayed (eg two or more probability plot windows), 
you can drag one window onto another to make a composite display. This process can be repeated as 
required. 
 
How To Use Colour Schemes 
Colour schemes are used in various parts of GeoAccessPro to define colour coding of variables in 
graphics displays. They can be used in Geotech Plans and Sections, StereoPlot, MultiPlot and 
Correlation Analysis. Colour coding can be applied using ranges for numeric variables and character 
strings for alpha variables. For strings, the * and ? wildcards can be used. 

  This is a typical colour scheme interface dialog. The dropdown list box with the 
entry ‘AU’ is the variable to be colour coded. The Current Colour Scheme being used is coming from a 
file called ‘au rainbow 0 to 14’, and the tick box shows that the colour coding option has been enabled. 
The Colour Schemes button is used to access the Colour Scheme Setup Dialog Box, which is shown on 
the right. Clicking on one of the colour boxes will bring up the standard Windows colour selection dialog, 
where the colour can be selected. 
For numeric variables the Generate button allows you to generate a series of ranges automatically. The 
Autofill Colours button will automatically fill the colour boxes with a rainbow as shown on the right. The 
Clear button clears all entries and colours 
The Numeric Mode button switches between alpha and numeric mode. 
The Load button allows you to load a previously saved colour scheme, while the Save button saves the 
current colour definitions.   
GeoAccessPro keeps track of the directory in which colour files are stored, so it is useful to keep all 
colour files in a common directory (called for example, ‘ColourFiles’). 
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How To Use Symbol Schemes 
Symbol schemes are used in various parts of GeoAccessPro to define symbols to be used in coding of 
variables in graphics displays. They can be used in StereoPlot, MultiPlot and Correlation Analysis. A 
special set of geological symbols is available for Geotech Plans. Symbol coding can be applied using 
ranges for numeric variables and character strings for alpha variables. For strings, the * and ? wildcards 
can be used. 

 This is a typical symbol scheme interface dialog. The dropdown list box with the 
entry ‘OX’ is the variable to be symbol coded. The Current Symbol Scheme being used is coming from a 
scheme called ‘OX TR FR’, and the tick box shows that the symbol coding option has been enabled. 
The Symbol Schemes button is used to access the Symbol Scheme Setup Dialog Box, which is shown 
on the right.  
Symbol schemes use Windows True Type fonts to draw symbols, and two pre-defined fonts are 
available, which can be toggled using Preset Fonts button. Any font available on your system can be 
used via the Change Font button. 
For numeric variables the Generate button allows you to generate a series of ranges automatically. The 
Clear button clears all entries and symbols. 
The Numeric Mode button switches between alpha and numeric mode. 
The Load button allows you to load a previously saved symbol scheme, while the Save button saves 
the current symbol definitions.   
GeoAccessPro keeps track of the directory in which symbol schemes are stored, so it is useful to keep 
all symbol files in a common directory (called for example, ‘Symbol Files’). 
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The special symbols available for the Geotech Plans function are shown below. 

 
 
How To Use The Clipboard and Save Bitmaps 

  You can send a copy of any graphics output screen to the Windows clipboard at any time using 
this button. The image can then be pasted into Word or any other application using the Paste | Special 
command – paste as a bitmap for best results. Note that with all graphic screens you can add a title 
block to make the image more informative.  Most functions have a Save Bitmap option on the popup 
menu which saves the image in a bitmap file. There is also a Save All Bitmaps option which generates  
bitmaps for all open windows. 
How To Get Hardcopy on a Printer or Plotter 

  Hardcopy output can be sent from any graphics screen directly to any printer attached to your 
computer or network. A dialog screen allows you to specify paper size, orientation and title block 
information. More information can be found in the Functions User Guide. 

  Scaled plots can be sent to a Windows-compatible plotter for the Geotech Sections, Geotech 
Plans and MultiPlot functions. A dialog screen allows you to set up paper size, orientation, scale and title 
blocks. More information can be found in the Functions User Guide. 

And a final note on Toolbars and Menus. After running any function, all further actions on the output 
can be performed either from toolbar buttons or from the menu that appears when you right click the 
active graph. Also, on the Main menu bar, the same menu options will be available and will apply to the 
currently active window. 

 

 

Contacts for More Help and Information 
Call Widenbar and Associates on (08) 9641 2877 or Fax on (08) 9641 2899 

Lynn Widenbar can be contacted on Mobile 0418 950 237 or email lynn@widenbar.com.au 


